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InteGrade Pro Quick Start

InteGrade Pro is a powerful program, yet it has been designed to be easy to use. This document is intended to help you get started quickly and easily.

Terminology XE "Terminology" 
Before we begin, it is necessary to define terms that will be used in this document:

    Input values are called scores. They are the marks that students receive on individual tasks such

                    as tests or homework assignments. 

    A task is a single assignment, test, quiz, exam, etc. Basically, a task is something students are

                     marked on. 

    Output values are called grades. They are the result of calculations that use scores; calculations

                      are performed according to the task and task type-weighting schemes. 

    A class is a single course taught in a single period as defined by your office administration

                      computer. There are ways of combining classes that your office considers separate into a single class for grading purposes, but they are outside the scope of this document. 

    A spreadsheet is a collection of tasks and scores for a single class. Each class can contain

                     multiple spreadsheets. You can use spreadsheets for various purposes. For example, at the start  of a new reporting period you can create a new spreadsheet so as to hide the previous reporting  period’s results. 

    A gradebook keeps track of all the students and classes you teach. InteGrade Pro uses one

                     gradebook per teacher, regardless of the number of students or classes taught. If you teach at more than one school, you should have a separate gradebook for each school. 

Starting The School Year With Information Pulled From The Main Office Computer System XE "Starting The School Year With Information Pulled From The Main Office Computer System" 

 XE "Starting The School Year With Information Pulled From The Main Office Computer System" 
The first thing you should do at the start of a school year is create a new gradebook and populate it

with information from your office administration system. This not only ensures that you don’t have to

spend a lot of time entering student information by hand, it also ensures that you can send your

student’s grades back to the office administration system at the end of the year.

How to do it: XE "How to do it\:" 
1. Start InteGrade Pro. 

2. When you are asked to open a gradebook, click Cancel. 

3. Choose "New Gradebook…" from the File menu. 

4. Click "Next" at the bottom of the window. 

5. "Create using class rosters" should be selected. If it is not, click it to select it. 

6. Click "Next" at the bottom of the window. 

7. The text on this screen explains how class roster files work and appear. Again, this information
isn’t important to you. 

8. Click Next. 

9. Click the down arrow to the right of Look in: and click on Integrade on ‘Srv____\Sys1”(I:).

10. Double click folder ____ (The underline will be a number for your building.  Example:  West might be 350, Mission might be 820)

11. Double click your own folder.  

12. Double click on the file Cl______.grd (This is the file with all your classes and all your students’ names.

13. Verify that you’ve selected the correct file by clicking "Next." 

14. Your last name will be on this window.   If you want it typed a different way on reports, change it now.

15. Click on the Set Password.   Type in a password.  You will be asked to retype it to verify it.

16. Click on Save at the bottom of the window.  

17. Give your grade book file a name in this new next window. 

 Example:  Yourname 1999-2000


18. In the narrow box at the top of the window, click the down arrow button.  Select  Integrade on ‘Srv____\Sys1”(I:).  Double click on the folder with the school number.

19. Double click on the folder with your name.

20. Click on the Save button on the bottom of this window. (Make sure you have a file name typed in before clicking save.)

21. Click NO on the error message that pops up.  The grade book should appear and you can begin customizing it a bit. (To make it larger, click on the ( on the top of the window.)

22. Skip to Setup Grade Tables for next step.

Note:  Be sure to save frequently in case of a power failure or computer crash.

Starting the School Year (Grade book) Without Importing Class or Student Data XE "Starting The  School Year (Gradebook) Without Importing Class or Student Data" 
You must setup a newly created gradebook before you can use it.  Setting up involves specifying some preferences, entering students into the gradebook, defining tasks, and listing class names. The first thing you should do at the start of a school year is create a new gradebook and populate it

with information

How to do it: XE "How to do it\:" 
1. Start InteGrade Pro. 

2. When you are asked to open a gradebook, click Cancel. 

3. Choose "New Gradebook…" from the File menu. The text on this screen explains grade books. None of this information is critical. 

4. Click "Next" at the bottom of the window.  The text on this screen explains the different methods of creating a gradebook. This isn’t important, but you might want to skim it. 

5. "Create without Classes or Students" should be selected. If it is not, click it to select it. 

6. Click on Next.  Enter your name as you want it to appear on reports.  The incomplete symbol can be edited also.  If this field appears dimmed, you cannot edit it.  Click on Set Password to create a password for your gradebook.  Follow on screen directions.  You will have to type your password twice.  Make it something you will not forget, but your students cannot guess. 

7. Click on Create.  The new gradebook is displayed in a class viewer. 

Setup Grade Tables XE "Setup Grade Tables"  

This is a must.  You have to change from the default A, B, C, etc to Bellevue Public Schools’ 1,2,3,etc method.  There are a couple of other things you need to do as well in this section.  A grade table converts percentage ranges to a letter/number grade. A grade table is required for all numeric spreadsheets.

Edit an Existing Table

1. From the Setup menu, choose Grading Rules, and then choose Grade Tables.

2. Select the Standard Table or any of the other choices.  Make sure you also edit and change grades for the Final Table to the Bellevue Public Schools' (or your own) grading criteria.

3. Change the A, B, C, notations to 1+, 1, 1-, etc.  Press the Tab key to move to the score/percentage box.    

If you are using plus and minus grades, you will run out of squares in which to define your grades.  When this happens, you must select the New button under the grading table you are changing.  This must be done for each additional grade.  Remember, you type the lowest score possible for the grade.


4. Click Close. The table is now available for use, but it is not saved until you save the gradebook.

Create a New Table

1. From the Setup menu, choose Grading Rules, and then choose Grade Tables.

2. Click New below the list of grade tables. 

3. Enter the grade table name and number of decimals.

4. Click New, under the Letter Grade/Lower Limit box.

5. Enter the Bellevue Public Schools grades and the lowest percentage allowed for that grade.

6. Repeat steps 4 and 5 for the remaining grades.  You will have to click the New button for each new grade choice.

7. Click Close. The table is now available for use, but it is not saved until you save the gradebook.

Delete an Existing Table

1. From the Setup menu, choose Grading Rules, and then choose Grade Tables.

2. Select the grade table to delete.

3. Click Delete below the list of grade tables.

4. Confirm the deletion. If the grade table is currently in use, the next table in the list is used as a 
replacement.

Setup Grading Types

1. This is a requirement of the program.  From the Setup menu, choose Grading Rules, and then choose Grade Tables.
2. Select the Type Sets tab.  To edit this section, use the first three buttons on the right to change the words across the top to something that makes sense to you.

Example:  Algebra II, English, or what ever you want it to say.

3. Next, use the last three buttons on the right to customize your own categories of grades. 

 If you want only one, you could type Student Work and type 100.  This means that all work will be averaged together.  If you want to keep your grades in categories, type the name of the categories and what percentage of the grade you wish each category to have.

Example:   Exams:     60
            Homework:     20
            Class work:     30


4. When finished click Close.

Add Students To The Gradebook (Manually) 

If you add students to a list downloaded from the AS 400, they cannot be electronically sent back. XE "Add Students To The Gradebook (Manually)" 
1. From the Setup menu, choose Students.

2. In the Students dialog box, click New.

3. Click Next to display the New Student dialog box. Enter the first
and last name of the student.

4. Click Next.

5. Select the classes the student is enrolled in. Click Create.

6. To add another student repeat steps 2-5.

7. When all students have been added, click Close.

Enter and Delete Classes In InteGrade Pro (Manually) XE "Enter and Delete Classes In InteGrade Pro Manually" 
1. Select Setup, then Classes.

2. Click New and type in the name of the class.  

3. Click on  Next.  Type the class name.  Example:  Algebra II, First Hour

4. Click Next.  Select Type.

5. Click Next and click next to each student you wish to add to the class.

6. Click Next, select the kind of spreadsheet you wish to use.

7. Click Next,  Add more classes here or click Done.


You might want to add several spreadsheets to this class.  One for each Quarter. See the next step to do this.

Add Extra Spreadsheets to a Class XE "Add Extra Spreadsheets to a Class" 
Rationale:  Each class can have any number of spreadsheets.  You might want to make one for each quarter.  This would keep all your grades for one class together in that class.

1. Select Setup from the top menu, and then select Spreadsheets.  
2. Next, select the New button on the bottom left side of the window.  

3. Click the Option button for the kind of spreadsheet you want to create:  numeric, attendance, or skill.  Most teachers will want to create a numeric spreadsheet.

4. Enter the name of the spreadsheet.  Example:  English-First Quarter, English-Second Quarter, English-Third Quarter, or English-Fourth Quarter.  

5. Click Create.  Repeat the first four steps for each spreadsheet.  If you are required to keep attendance, make one for attendance as well.  


If you created a numeric spreadsheet, assign a grade table to the new spreadsheet by using the down arrow to the right of the Grade Table box.  Also, use the down arrow to select the way the grades will be calculated (either weighted or total points). 

Switching between classes XE "Switching between classes" 
Unless you only teach one class, you’ll need to switch between classes in the gradebook.

At the top left of the main viewer window there is a popup menu for displaying classes. Just click the

Pop-up menu and select the class you want to view. (Macintosh users: you may need to hold down the

mouse button until after you have selected a class.)

The class viewer will instantly switch to the class you selected.

Below the class popup menu there is a spreadsheet popup menu. Each class can contain one or more

Spread sheet. You can use this popup menu to choose between different spreadsheets in your class.

Set up Tasks XE "Setting up Tasks" 
You need to define tasks (assignments) that your students will perform. You can add a task at

Any time during the reporting period. 

Create A New Task (the grades given to students for an assignment) XE "Create A New Task (Set of Grades)" 
1. Choose "New Task…" from the "Tasks" menu. 

2. You’ll see an explanation of how tasks work. This isn’t important, but you might want to skim it.

3. Click "Next." 

4. Enter a name for the task. This name can be as long as you want and will appear on reports, so
describe the task in a meaningful way. 

5. Enter a due date for the task. The format you enter the date in is displayed beside the due date
entry area and depends on the settings you made in the display dialog earlier. 

6. Select a task type from the popup menu. 

7. Enter the number of points the task is out of into "Out Of (Raw)." 

8. If you want to protect yourself from entering a score too high, enter the highest score you will
assign into the Maximum Allowed Score entry field. 

9. Click the "Create" button to create the task. 

Entering scores XE "Entering scores" 
Once you have set up a task, you can enter scores for students. Scores fields are empty by default

so you can easily see what you haven’t done yet. 

1. To enter a score, find the score column on the main spreadsheet. The score entry column is in the bottom center of the window to the right of the student names. 

2. Find the student you want and scroll to find the task.

3. Click on the spreadsheet cell and enter the score.

As you enter scores, InteGrade Pro will start recalculating the student’s grade and any other

information that depends on that score. If you watch the lower right corner of the screen you will see

the progress of these calculations. You don’t need to wait for these calculations to complete to enter

another score. If you perform an operation that requires calculations to be complete (such as printing

a report), InteGrade Pro will automatically complete the calculations.

InteGrade Pro has been designed to be intuitive and easy to use. Experiment with the software. If you

have a question about InteGrade Pro or need more information, use the help system or the full user

guide.

Reports XE "Reports" 
Class Roster Report XE "Class Roster Report" 
One of the most useful reports InteGrade Pro prints is the Class Roster report. Class Roster reports

are useful for gathering data during class or other locations where you don’t have convenient access

to a computer.

Print A Class Roster Report: XE " Print A Class Roster Report\:" 
1. Choose "Class Roster" from the Report menu. 

2. You’ll see a few options, with which you can customize the report. For now just click "Next." 

3. InteGrade Pro will present you with a preview of the report. You can click "Print" to print this
report or "Cancel" if you’ve changed your mind. Other options available to you are described in
the help system: click the Help button for details. 

Carry this report with you and write down information as you get it. You can enter this information

into your InteGrade Pro gradebook later.

Student Progress Report XE "Student Progress Report" 
The student progress report is a great way of printing interim report cards for students.

Adding Grade Level to a Report in Integrade Pro
1. Click on Reports.
2. Click on Student Progress.
3. Click on the Setup button.
4. Click on the little circle to the right of Other,  and then click on the down arrow until you find Grade Level.
5. Click on OK, then on Next at the bottom of the window.
6. Click on the report to have it enlarged to be able check it.  The grade level should be in parenthesis next to the student’s name.
Print A Student Progress Report XE "Print A Student Progress Report" 
1. Choose "Student Progress" from the Reports menu. 

2. You’ll see a complicated dialog. In this dialog, you can select a subset of students on which to
report. Each student takes a minimum of one page to report, so if you are using this report just to
try it out you may wish to uncheck some of the students. 

3. Many other options are available. See the online help for details if you want.  For now, just click "Next." 

4. Again, you are presented with a preview of the report. There is now a scroll bar at the top of the
window. You can use this scroll bar to switch between the pages of the report. 

5. Click "Print" to print all the pages of the report, or "Cancel" if you’ve changed your mind. You
can go back to the window used to configure the report by clicking the "Back" button. 

Attendance

Recording Attendance

1. Switch to the Attendance spreadsheet in the viewer.

2. Activate the day for which you are recording attendance. If a day is not activated, InteGrade Pro assumes it is a non-instructional day and you cannot enter attendance.

3. Right mouse click in the cell and choose the appropriate attendance code for each tardy or absent student. Leave the cell blank for students who attended the class. A blank cell indicates that the student is present.

4.  Save the gradebook.

Exporting Attendance to the Office 

1. From an attendance spreadsheet, click the column header containing the date you want to export. For example, Tuesday, March 28th. You can also right-click any cell in the column.

2. Note:  If you are taking attendance from a seating chart, right-click a student's desk and select Export This Day's Attendance from the drop down list.

3. From the drop-down list, select Export This Day's Attendance.

Note:  On the Seating Chart view, simply press the Export Attendance button when you are viewing the day you wish to export.

4. A message displays asking if you want to proceed with the export. Click Yes.

5. A progress bar displays indicating that the attendance data has been exported.

Exporting Data To Your Office Administration System XE "Exporting Data To Your Office Administration System" 
At the end of each reporting period you will be asked to send your students’ grades back to the office

administration system for printing report cards.  You can only do this if you have imported students from the office administration system

The AS400 folks at the main office create the quarter and semester spreadsheets.  Below see the directions of exporting your data.

Integrade Pro Short Version for End of Quarter and End of Semester Grades

Submitting Quarter and Semester Grades

Set up classes from the AS400 (refer to the specific details in your packet) If you have not already done so.

1. Start InteGrade Pro.

2. When you are asked to open a gradebook, click Cancel.

3. Choose "New Gradebook…" from the File menu.

4. Click "Next" at the bottom of the window.

5. "Create using class rosters" should be selected. If it is not, click it to select it.

6. Click Next.

7. Click the down arrow to the right of Look in: and click on 810 on SrvLogan

8. Double click your own folder.

9. Double click the file CLxxxx.GRD (the xxxx is your name and this is the file with all your classes and your students).

10. Click Next.

11. Verify that you have selected the correct file by clicking Next.

12. Your last name will be on this window.  If you want it typed a different way on reports, change it now.

13. Click on the Set Password.  Type in a password.  You will be asked to retype it to verify it.  Click on OK.
14. Click on Save at the bottom of the window.

15. Give your grade book file a name in this new window.
Example:  Grades 1999-2000 or McGregor 1999-2000 (this is up to you)

16. In the narrow box at the top of the window, click the down arrow button.  Select 810 on SrvLogan.
17. Double click on the folder with your name.

18. Click on the Save button on the bottom of this window. (Make sure you have a file name typed in before clicking save.)

19. If an error message pops up, click NO.  The grade book should appear and you can begin customizing it a bit.  (To make it larger, click on the top of the window.)
NOTE:  Be sure to save frequently in case of a power failure or computer crash.

How to Sort Student Names

1. Click on Student Name in the middle of your screen.

2. Click on Sort Students.

3. Click on Sort.

To Type in Quarter 4 and Semester Grades

1. Select the End of Term spreadsheet Quarter 4.

2. Push the Num Lock key. (This is the set of keys on the right with only numbers on them.)  Use these keys for entering grades.

3. Type in the letter grade the student received (1+, 1, 2-, etc.).

4. Click on File and Save Gradebook.

5. Select the End of Semester spreadsheet.

6. Type in the letter grade the student received for the semester.

7. Click on File and Save Gradebook. Repeat steps 1-7 for each class.

8. Click on File and Save Gradebook (see number 7 to make sure you save in your folder.)

9. Click on File and Export from gradebook.

10. Follow the on screen directions.

11. If you need to leave the room with your grades open, you can lock the workstation so that you don't need to log in each time.

For Study Skills (Logan)


1. Click on Quarter 4 spreadsheet.

2. Click on the word Quarter 4 in the last column.

3. Click on Fill Column.

4. Type in a P in the New Score box.

5. Click Fill.

To Lock a workstation

1. Hold down CTRL + ALT + Delete.

2. Click on Lock Workstation.

To unlock a workstation

1. Hold down CTRL + ALT + Delete.
2. Type in your password.

Get More Help With InteGrade Pro XE "Get More Help With InteGrade Pro" 
Online help can answer many of your questions. There are different ways to use it:

1. Choose Contents from the Help menu (Windows/MS-DOS) or choose InteGrade Pro Help from
the Help menu (Macintosh). This opens the table of contents and lets you browse the help
system or search for specific topics. 

2. Choose "How Do I…?" from the Help menu to jump directly to instructions on completing
various tasks in InteGrade Pro. 

3. Click the Help button in a dialog box or press the F1 key (or the Help key on the Macintosh).
This opens the help topic most relevant to the task you are doing. 

4. Also, visit the unofficial web page to <http://www.integrade.com>.

5. Read the documentation that came with the CD ROM.  At least one copy will be placed in your Media Center.
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